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Alexandria Controller

COMPanion offers our users the Central Union, Distributed Union, and single-site systems for library
management; however, there are times when even this variety of system models cannot conciliate specific
needs. Therefore, the Alexandria Controller™, a new model based on Multi-Data Station technology,
provides yet another solution—continuing to make Alexandria the perfect system to fit everyone’s needs!

A Solution To A Technological Headache
Multi-Data Station technology provides an answer to the problem of growing hardware and software
requirements that have faced district technical staff, school district administrators, and librarians.

District information technicians are faced with increasing demands as more and more computers and
programs are amassed. In order for districts to efficiently use their technical support staff, administrators
are constantly looking for ways to cut back on activities that consume unbounded amounts of time. Some
districts experiment with consolidating servers and software in attempt to reduce their technician’s travel
time. Many information technicians prefer Alexandria’s Central Union library system because maintaining
a program with a single database housed on a single server is preferable to having one server for every
database for each library.

School district administrators are also constantly faced with budgetary shortages. Therefore, they must
make the best use of the funds available for staffing and resources. Increased technological demands means
increased need for servers, computers, and technical staff for maintenance.

School librarians want to provide what is best for the students and staff that they serve. Within a district,
the needs of elementary and secondary schools vary greatly. The needs of students in an affluent area of a
district will differ from those in recognized lower-income areas. In addition, librarians feel the autonomy
that they have in setting policies and purchasing materials to fit the needs of their school population is
crucial in providing the best service possible. While librarians can appreciate the benefits of sharing
materials and being part of one centralized library system—when all policies and resources are
standardized, it may actually be a far more inferior method of servicing the needs of their schools.
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Welcome to the Alexandria Controller!
Now, with the Alexandria Controller, the technical staff, district administrators, and librarians can have a
system that meets all of their collective needs. 

Multi-Data Station technology saves time!

Running numerous Data Stations on a single server saves your information technicians time.
Instead of having to go from school to school to maintain individual library systems, all Alexan-
dria Data Stations can be housed on a single server. This server may be located in a district loca-
tion rather than a school. This enables the technical staff to have easy access to the server and to
save travel time as well as the maintenance time required when multiple servers are needed.

Fewer machines saves money! 

Purchasing fewer servers will save the district money and provide a more cost-effective use of
technical staff—circumventing the need to hire additional technical support. 

Librarians retain autonomy!

Librarians will be able to customize their library systems and services to best serve the needs of
their students and staff. Policies, purchases, etcetera, will be made on the local level for a better,
more individualized service. 

Each collection is completely autonomous and will be managed and searched separately, just as if
they were separate servers running on separate machines.
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Installing Alexandria Controller Alexandria Controller
Installing Alexandria Controller 
This section will help guide you through the Alexandria Controller installation process.1 Make sure to have the
registration letter that came with your software—it contains essential product code information required
during installation.

If you have questions or problems during installation, contact COMPanion's 24-hour Technical Support
Service at (800) 347-4942 or (801) 943-7277 or by email via: support@companioncorp.com

Hardware and Operating System Requirements
The Alexandria Controller has been developed to work under both Windows and Macintosh-based operating
systems. With the exception of subtle differences between the controls at the tops of windows and minor
differences in operating system functionality, the program operates identically across both platforms. 

Here are the minimal hardware and operating system requirements for an Alexandria Controller:

Alexandria Controller Communication Systems
The Alexandria Controller requires TCP/IP to communicate between managed Data Stations and their clients.

1.During instruction, COMPanion assumes that you have a basic working knowledge of your computer’s operating system.

System Requirements for Alexandria Controller

Minimum Recommended

Mac OS 10.4, Windows 2000+ Mac OS 10.4 Server, Windows 20003 Server

G5 or X86, Dual Processor/Core G5 or X86, Dual Processor/Core

2GB of RAM 4GB of RAM (or more)

20GB of free HD/100,000 Items 20GB of free HD space/100,000 Items

TCP/IP Network TCP/IP Network

¡ W A R N I N G !

The address for each Alexandria Data Station cannot be dynamically allocated and
must have a fixed TCP/IP address.
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Installation Summary (read this first)
Make sure that the machine on which you will be installing and running the Alexandria Controller meets the
minimum recommendations for both hardware and operating system software. 

Step 1. Before you run the Alexandria Controller, you will need to have a unique and static IP
address assigned to each collection or Data folder that you wish to manage—including an
additional IP for the Controller component itself. You can configure and add additional IP
addresses to your existing (or secondary) ethernet controller using your operating system’s
standard network settings. 

On Windows, these settings can be found under the Internet Protocol (TCP/IP) connection
properties for your network connections. On Macintosh these settings can be located and
configured from your Network system preferences.1 

The Alexandria Controller does not need to be restarted in order to find IP addresses that
were newly added using your operating system’s network configurations.

Step 2. Download the most current version of the Alexandria Controller (www.goalexandria.com).
COMPanion’s Technical Support staff recommends that this file be saved to your operating
system desktop. 

Step 3. Run the Alexandria Controller installer by double-clicking on the Installer.exe executable
(Windows) or the Installer.dmg disk image (Macintosh).2 To proceed with the installation
of the Controller, follow the on-screen prompts and accept the terms of the COMPanion
Corporation Electronic End User License Agreement. 

Step 4. After completing the installation, close the installer application (if applicable) and launch the
Alexandria Controller by double-clicking on the newly created desktop shortcut.
Alternatively, you can open the Alexandria Controller’s program folder (i.e. installation
directory) and launch it from there. 

On Windows, the Alexandria Controller executable will be located, by default, at:
     Hard Drive (typically C:) > Program Files > Alexandria Controller

On Macintosh, the Alexandria Controller application package can be found at:
     Hard Drive > Alexandria Controller

Make sure that any other COMPanion software applications that may be running on this
machine (e.g. Textbook Tracker, eLunchroom) have been shut down before attempting to
run the Alexandria Controller.

1.If you are inexperienced with TCP/IP protocols, please have your Information Systems Technician (or Information Technician; IT for
short) set up multiple IP addresses—one for each data set. Otherwise, feel free to call COMPanion’s Technical Support team at (800) 347-
4942 or (801) 943-7277 or by email via: support@companioncorp.com.
2.These files will most commonly be called Alexandria Controller Installer.exe and Alexandria Controller Installer.dmg.
ntroller User’s Manual



Installing Alexandria Controller Alexandria Controller
Assigning the Controller an IP Address
The first time you launch the Alexandria Controller, you will be asked to select the IP address that you
wish the Controller to permanently use.

Select the desired address from the Choose from List window and then click OK.

Registering the Controller
Proceed to register the Alexandria Controller using the information provided on the product registration
letter that came with your program. Enter the Registered To name, Product Codes, Serial Number
and Validation Code from your registration letter and click OK.

After the successful entry of your registration codes, you will be presented with Alexandria Controller’s
user interface (documented on page 12). 

- N O T E -

The first time that you launch the Alexandria Controller, a series of progress bars will
appear at the bottom of the interface while the program rearranges some essential
client resources and builds client applications. Please allow these processes to finish
before proceeding. After these utilities have completed, you are ready to import
existing or create brand new data collections.
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TECH NOTE:
Alexandria Controller 

creates a new
“.acf” file in the 

Client Applications 
folder for each new

Data Station you add.

When a Data Station’s IP 
address is changed, it’s 

“.acf” files are 

NOTE:
Once registered, the 

Alexandria Controller 
will omit its own IP 

address from the
Choose from List 

window as a 
viable option.
Adding or Creating Alexandria Data Stations
There are two methods available for importing an existing Alexandria Data folder into the Controller. 

First, you may drag-and-drop an existing Data Station’s Data folder onto the main Controller window;
otherwise, you can click the Add button on the main Controller window. Clicking this button will give
you the choice of adding an existing Data folder or creating a new one. If you choose to Add an existing
Data folder, a standard operating system explorer (i.e. finder) window will appear, allowing you to guide
the Controller to the directory folder containing your existing data collection.1

If you choose to Create a new Data folder set from scratch, you must be prepared to complete the
required registration information for the newly created Data Station. Attempting to add a Data set whose
Serial Number already matches that of a Data Station managed by the Controller will cause a warning
message to appear.

Before the final importation/creation of new data can be implemented, you will need to select a static IP
address for every individual Data Station—just as you did for the Alexandria Controller (see page 5).

Select the desired address for the new Data Station from the Choose from List window and then click
OK. Otherwise, click Cancel to return to the main Alexandria Controller interface window.

Now that you’ve added a new Data Station, the first thing you should do is Edit [that] Data Station’s
Preferences (see page 17) and add your administrative-level users so that they can remotely install client
workstations; also, if required, you can change your Data Station’s available web ports. Please refer to the
v5.5 Alexandria User’s Manual for more information on creating users and changing ports.

1.The Alexandria Controller will not move an existing Data folder. Instead, a copy of the selected Data folder is made so that your
original collection information is left untouched. The Alexandria Controller is able to work around set file permissions; the Controller
can copy any application bundle, even when it’s set to Read only.
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Activating Alexandria Data Stations
The Alexandria Controller has the ability to Start and Stop the individual Alexandria Data Stations that it
manages. When you Add an existing or Create a new Data Station, they will initially appear as Stopped
in the main Controller interface window.

From the list, select (highlight) the Data Station you would like to activate and click the Start button. 

You are only allowed to activate one Data Station at a time However, if the Alexandria Controller is shut
down and then restarted, all of the individual Data Stations will be automatically activated.1 If, for some
reason, one of your Data Stations fails to auto-start on launch, an “unable to start” error message will
be recorded in the log.

Once a Data Station in your list has been activated, you should see a green-colored icon and the word
Running, along with the web port that it’s using, located under the name of the collection.

At this point, an activated Data Station is broadcasting—awaiting web connections on Web Port 80 (set as
default), and ready to communicate with your Alexandria client workstations.2 

1.This can be overridden if you hold down the <shift> key while launching the Alexandria Controller.

- N O T E -

As stated on the previous page, the very first thing you should do after adding and
activating a new Data Station is edit their essential Preferences (see page 17). Please
refer to the v5.5 Alexandria User’s Manual for detailed preference information.

2.The Alexandria Controller acquires root privileges before it launches each Data Station so that it can listen on restricted ports.
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Installing Client Workstations
If an individual Data Station license supports multiple users, you can install Alexandria’s Researcher and
Librarian clients on remote computers over the World Wide Web.

In order to install clients over the World Wide Web, make sure that you have an Administration User
Name and Password set up in the Administration preferences of your selected Data Station. You must
also have the latest Java applet installed on your computer. If you don’t, the following steps will instruct
you on download and installation procedures. 

Step 1. Make sure that the Data Station from which you’d like to install the client is Running (i.e.
activated) in the Alexandria Controller management list.

Step 2. Open an internet web browser (e.g. an Internet Explorer, Firefox, or Safari web-browsing
window) on the machine where the client is to be installed. 

Step 3. In the browser’s Address field (located in the upper-left corner of the window), type the IP
address of your Alexandria Controlled Data Station followed by “/install”.
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Installing Client Workstations Alexandria Controller
If you are unsure which IP address your Data Station uses, it can be located to the right of
the Registered To name and Serial Number in the Alexandria Controller management
list. 

If you still have problems locating your IP address, please contact your network adminis-
trator for further assistance. If your network administrator is not available, feel free to con-
tact the COMPanion Technical Support team.

Step 4. If you performed that step correctly, the Alexandria Web Installer page should appear.

Step 5. If you don’t have the correct Java applet installed on your computer (in this case, Java
Plug-in 1.3 or higher), you will be required to install it before you can download clients.
Your browser should automatically detect whether you have the correct Java version
installed. If it does not, follow the links and install instructions that the web page pro-
vides.

Step 6. If your Java plug-in is up-to-date or you have just installed it, click the Grant this ses-
sion button on the Java page to begin your Web Install session. You are allowed to down-
load a Windows or Macintosh Workstation.
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NOTE:
The very first thing you
should have done after 

adding a new Data Statio
to the Controller is to us
the Edit Data Station’s

Preferences (see page 17
menu selection to add you
administrative-level users

 Please refer to the v5.5
Alexandria User’s Manua
for more information on

creating users
Step 7. A pop-up dialog box will require you to input your Login User Name and Password.
Your user name and password are the same as those that are found on the Administration
preferences window of your Alexandria Controlled Data Station (see note in margin).

Step 8. The client application will be downloaded to your machine. After it has finished down-
loading, an Alexandria folder will appear on your operating system desktop with the
appropriate application files inside (this folder can be moved anywhere on your machine,
it’s only downloaded to the desktop to make it easier to find).
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Manual Installation of Client Workstations
Alternately, Researcher and Librarian workstations can be installed manually by moving a copy of the
client application to a permanent location on the hard disk drive of the machine where it is to be installed.
These client applications can be found in the Alexandria Controller Support folder. 

On Macintosh OSX machines, this folder is located in the following directory:

Hard Drive > Users > Shared > Library > Alexandria Controller Support
On a Windows machine, the shared application folder should be kept here:

Hard Drive (typically C:) > Program Files > Alexandria Controller

You can locate the Librarian and Researcher workstation installers in the Client Applications folder. Be
sure to copy the entire folder for each client you wish to install. 

- N O T E -

When a Data Station is running under the Alexandria Controller, be aware that you
will need an Administrator Username and Password when installing or configuring
new client workstations.
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The Alexandria Controller Interface
Now that you’ve added all of your managed Data Stations and installed all of your client workstations, the
Alexandria Controller is fully operational and ready to go! 

Now, let’s delve a little deeper into some of the more technical details of the Controller and its interface.

The main Controller interface window is easily broken down into two distinct sections. 

The top half of the main Controller window contains your list of managed Data Stations. This list
contains information about which Data Stations are active or stopped, their names, serial numbers, IP
address, and port numbers.

The list of managed Data Stations can be rearranged and reordered by selecting (highlighting) the desired
Data Station and dragging it above or below other existing Data Stations.

You may right-click (Windows) or <ctrl>-click (Macintosh) on any Data Station in this list to open the
Controller menu (see “Controller Menu” on page 17 for more information). The Controller menu allows
you to Add or Remove a Data Station, assign an IP address, or edit the Data Station’s preferences.
ontroller User’s Manual



The Alexandria Controller Interface Alexandria Controller
If you select (highlight) a specific Data Station from the list, it will turn blue—allowing you to use the
Start button to activate the Data Station (if it is stopped) or use the Stop button to deactivate a Data
Station (if it is running).

You may also click on the Add button, causing a message window to appear. You will be given a choice to
Add a new Data folder or Create a new one. If you wish to do neither, click Cancel.

For more information on importing or creating new Data Stations, please review “Adding or Creating
Alexandria Data Stations” on page 6.

The Controller Log
The bottom half of the main interface window contains the controller log. The controller log captures and
stores all pertinent Controller information, including when each Data Station is stopped or started, and
any special operations (e.g. archive or rebuild) that have been performed.

While in this section, you may select Print from the File menu to print the log. The controller log is
automatically saved by the Controller. Logs are saved inside the Log folder, located in the Alexandria
Controller Support program directory.
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Alexandria Controller Menus

The Alexandria Controller menus follow operating system standards for Macintosh and Windows. For
example, the File and Edit menus in Alexandria Controller are very similar to the File and Edit menus in
other applications. Additional menus have purposes specifically related to Data Station management. 

Alexandria Controller/Help Menu
If you are using Macintosh, there is an Alexandria Controller drop-down menu that contains
the About Alexandria Controller and Quit Alexandria Controller selections. There is also a
Help menu that contains Alexandria Help and Open Release Notes selections.

On Windows, all these selections are located under the Help menu. 

About Alexandria Controller
Shows copyright and version information.

Alexandria Help
If the Controller Help documents are installed on your system, this menu selection opens them.

Open Release Notes
If the Alexandria Controller release notes are available, this menu selection will display them.

Quit Alexandria Controller
Quits the Alexandria Controller program.
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File Menu
The Alexandria Controller File menu provides the following selections.

New Document—Opens a new COMPedit document. COMPedit is the Alexandria Control-
ler’s integrated word processor.

Open—Opens the standard operating system explorer window used to locate files. When you
select a document from this window, the Controller will open it (if it is able). Use this command
to open COMPedit documents, TEXT documents, and other files for viewing. 

Close Window—Closes the top window. 

Close All—Closes all windows except for the main Controller interface window.

Save—When enabled, saves the contents of the top window. 

Save As Text—Saves a copy of the currently visible COMPedit document as a TEXT file.

Save As RTF—Saves a copy of the currently visible document in a rich text format1. 

Save As—Allows you to save “.vwp” documents to specific locations on your hard drive.

Revert—Changes made to the current document are discarded and the original document is dis-
played in the COMPedit word processor.

Utilities—Utilities are used to check for updates and download the newest resources for your
Alexandria Controller (see “Alexandria Controller Utilities” on page 36). 

Page Setup—Operating system standard function that sets the page up for printing.

Print—Prints the contents of the COMPedit window or any other window that has focus.

Print to PDF—This allows you to save any finished reports or COMPedit documents as Adobe
PDF files (Macintosh only).

1.An RTF file is basically just an ASCII file with special commands to indicate formatting information, such as fonts and margins.
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Edit Menu
This menu includes standard editing functions. You can cut, copy and paste text, clear a field, select all
text, and paste from a file. Information about commands which are specific to the Alexandria Controller
are included below. 

Undo Typing—This command only undoes typing or cut-and-paste operations in individual
fields or in the word processor. It does not undo operations from other menus, commands and
controls.

Redo/Can’t Redo—An undo for the undo.

Cut, Copy and Paste—You can cut, copy, and paste text from certain fields to others within the
Alexandria Controller.

Clear—Clears the selected text or selected list elements. 

Select All—Selects all the text in the current edit field, current word processor document, or list.

Find—This selection opens the Find window. Dependant upon which window is open, Find can
be used to locate specific information or text in a word processing file. 

Find Again—Finds the next piece of matching information in a COMPedit document.

Paste From File—Allows the user to paste information from a file.

Preferences—This selection opens the Preferences window. Preferences are used to customize
the Alexandria Controller to suit your needs (see “Alexandria Controller Preferences” on page 19).
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Controller Menu
This menu only appears when the main Alexandria Controller interface window has focus. You can also
right-click (Windows) or <ctrl>-click (Macintosh) anywhere on the Controller interface window to
force this menu to appear.

Add Data Station—This selection does the same thing as clicking the Add button on the Con-
troller’s main interface window (see “Adding or Creating Alexandria Data Stations” on page 6).

Remove Data Station—This selection does the same thing as clicking the Remove button on
the Controller’s main interface window. If you have a Data Station selected (highlighted) in the
management list, this selection will become available.1 Use caution; once you’ve removed a Data
Station from the Alexandria Controller, it can not be restored.

Set Data Station’s IP Address—If you created a new Data Station but had no IP addresses
available during its inception, the Data Station will still be added to the Controller list. However,
it will appear as Stopped until you’ve supplied it with a working IP address. 

Once you’ve set up additional IP addresses using your operating system’s network configuration
tools, you can use this selection to assign the highlighted (selected) Data Station one of the newly
created IP address (see “Adding or Creating Alexandria Data Stations” on page 6).

If only one IP address is available, the Controller will automatically skip the Choose from List
window and assign the last remaining IP to an addressless Data Station.

After the Data Station has been assigned an IP address, it is immediately activated.

Edit Data Station’s Preferences—The Alexandria Controller is allowed to edit the preferences
of every Data Station it manages. After a Data Station is up and Running in the Controller’s
management list, you may choose to remotely edit all of that Data Station’s Preferences. The
Controller will ignore the Data Station’s auto-save settings when it’s preferences are being edited.

Because Alexandria Data Station preferences are too abundant to mention here, please refer to
the v5.5 Alexandria User’s Manual preference chapters for complete and detailed descriptions.

Edit Data Station’s Registration—This will open the Data Station’s Registration window,
allowing you to update your registration information. The Alexandria Controller will require a
restart once your registration information has been updated.2

1.The Remove Data Station selection is disabled until the selected Data Station you wish to remove has been Stopped.
2.This menu selection will only become available after you’ve Stopped the selected Data Station from running.

- N O T E -

Some of the selections in the Controller menu (e.g. Remove Data Station or Edit
Data Station’s Preferences) will appear grayed-out and disabled until you have
Stopped the selected Data Station from running.
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Show Menu

Use this menu to move between various Controller modules (if available).

Window Menu
As you open new windows in the Alexandria Controller, the Window menu will display a list of
all currently active windows. The example Window menu in the margin shows that the Alexan-
dria Controller window is open and active and the Preferences and Utilities windows are also
open. 

To choose a window, select it from this menu. The window you select gets focus and becomes the
active window.

If you select Bring all windows into view, all minimized windows will appear, with focus placed
on the Controller’s main interface window.

When you close a window, it is removed from this menu. 
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Alexandria Controller Preferences
Although you’re required to make changes to the individual Data Station preferences that your Alexandria
Controller manages—the actual Controller also contains some preferences of its own. However, these
preferences are limited to just a few panes containing globally-based settings.

The Alexandria Controller’s Preferences are used to customize security settings, email information, and
scheduled events for all managed Data Stations. 

The top portion of every preference window consists of a drop-down menu and two standard Alexandria
Controller buttons. The drop-down menu on the left is the Preference selection menu. Use this menu to
shuffle through Alexandria Controller’s various preference windows. For more information on an
individual Controller preference window, please review its corresponding section in this document.

On the far top-right of every preference window are two Alexandria Controller standard buttons. The first
button is a preference specific Restore/Revert button. This button will restore the Alexandria Controller
preference windows to its original settings; reinstating any information or fields that were supplied via
registration codes.

The second button is the Alexandria Controller standard Help button. 

The sections that follow will describe, in detail, each preference window and then demonstrate how to use
them. 

To set up or change Alexandria Controller preferences, you must first activate the Preferences window
from the Edit menu. You may also use the “Ctrl+;” (Windows) or “Cmnd+;” (Macintosh) shortcut
command. Once the Preferences window appears, click on the drop-down menu in the upper-left corner
of the window to view your available preferences.

- N O T E -

Since the Alexandria Controller and Web Router only contain global-based
preferences, they will not show Local/Default Local drop-down menus.
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Administration Preferences
Set up Alexandria Controller users and access levels; activate passwords.

Users Tab
The Users tab of the Administration preference window allows you to setup and create any number of
Alexandria Controller users, each with their own unique (or identical) security level. Although you may
have users with duplicate security levels, you can not have duplicate user names.

This window contains a large Alexandria Users field, which is basically a list that contains the Name
and Security Level(s) of your existing Alexandria Controller users; you may select (highlight) any of the
users contained within this field in order to edit their information or remove them completely. 

This preference tab also contains the Add User, Remove User, and Edit User buttons (located at the
bottom-left corner of the window); these buttons allow you to create, remove, and edit Alexandria
Controller users. The subsequent pages will further detail the usage of these buttons.1

1.For more information on Security, please see “Activating Security” on page 21.
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Activating Security
Check the Require User Login box on the Administration Users preference window to activate the
Controller’s Log In security. When this box is checked, the Alexandria Controller will require a username
and optional password1 every time that the program is launched.

Even if you haven’t yet logged in, the Alexandria Controller will be running from the moment you see the
Alexandria Log In window—all Data Stations will have already been activated.

Use the Require Password to Quit From Log In Window checkbox to force users to provide an
acceptable password when attempting to Quit from the Log In window.

When the Alexandria Controller Log In window appears, enter the appropriate Username and optional
Password and click Log In to access the Alexandria Controller.

The username that you enter during log in will be recorded to the Controller log as well as any failed
login attempts.

1.If a password was not supplied when creating a new user in the Add User window (page 22), then this field will not be required.
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Adding Users
Click the Add User button (the red “+” icon), or use <cmnd+N> (Macintosh) or <ctrl+N> (Windows),
to add a new user to the Controller. The Add User window will appear, requesting that you provide
specific new user information. 

Enter the username1, a password2, confirmation password, email address, security Level for the new user.
If you have not previously created any users, the Level drop-down menu will be set to District
Administrator and you will be unable to change it. Once you have created a District Administrator, you
can add other new users with access levels other than Administrator. 

If you would like to add an user’s picture at this time, you can import a GIF, BMP, PIC, JPG (or any other
standard image file); here are some ways that you can do this:

Drag and drop—Open the picture with your system’s default picture viewer. Drag the graphic
from the desktop or program onto the Controller’s Add User window. As you drag the picture, a
box outline shows where the picture is to be placed to help you align it properly.

Paste and Copy User Picture3—Open the picture with your system’s default picture viewer.
Select the graphic and copy it to your operating system clipboard (this is usually done with com-
mands such as Select All, Copy, and Cut under the Edit menu in the program). Go back to the
Controller’s Add User window and choose Paste Patron Picture by right-clicking (or ctrl-click-
ing using a one-button mouse) in the patron picture field. The picture should now appear in the
area located to the right of information fields.

1.If you choose a username that is already in use, the Controller will ask you to choose another.
2.Passwords are not case sensitive. Upper and lowercase characters match. Although you may leave the Password field blank (meaning
that a user requires no password upon Log In), it is strongly recommended that this is not done.
3.Windows users are required to have Apple’s QuickTime installed to view some picture formats.
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When you click the OK button, the new user Name and Security Level will appear in the Alexandria
Users field of the Users tab.

Removing Users
To remove an Alexandria Controller operator, select (highlight) the user Name from the Alexandria
Users field and click the Remove User button (the red “minus” icon). If you have Alexandria Users
with security levels other than Administrator (e.g. Librarian or Aide) you will be unable to remove the
District Administrator unless you have another existing District Administrator.

Edit Users
You may edit the username, password, email address, and security level of any existing Alexandria
Controller user. To edit an existing user’s information, double-click on a user’s name in the Alexandria
Users field. Alternately, you may select (highlight) the user’s name from the Alexandria Users field and
click the Edit User button (located at the bottom left-hand side of the window). Doing this opens the Edit
User window (similar to the Add User window described on page 22); using this window, you may
change any of the user information fields.
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NOTE:
Usernames and passwords 

are not case sensitive. 
Security Tab
The options contained on the Security tab of the Administration preference window allow an
administrator to modify existing or create custom security levels for Alexandria Controller users. A user’s
security level determines what Alexandria Controller operations the user is allowed to perform.

The Alexandria Controller comes standard with several default security levels; from District Administrator
to Researcher, including two Self-Service security levels. District Administrator is the least restrictive
and allows unlimited access to Alexandria Controller preferences and settings. Researcher is the most
restrictive security level.

Alexandria Controller also allows users to create their own custom security levels by manipulating a list of
permissions (see page 25 for more information on customizing security levels). 

Until you set up a District Administrator user and enable Require User Login, Alexandria Controller will
launch with full administrative privileges. An Administrator is the only security level that allows you
create new Alexandria Controller users. Once you’ve established an Administrator, if no other security
level is selected, then Administrator-level access will be the default upon launch.
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NOTE:
By default, only the 

District Administrator 
can add custom or edit 
existing security levels. 
Adding, Editing, and Removing Custom Security Levels
Users with the appropriate authority can add, edit, or remove any of Alexandria Controller’s security levels
with the exception of the default security levels, which can be edited, but not removed or renamed.

Add—This button (the red “plus” icon located in the lower-left corner of the Administration
preference window) opens the Create New Security Level window; this window is docu-
mented on page 26. 

Remove—Users with the appropriate authority can remove a user-created security level by high-
lighting (selecting) the level from the Security Levels section of the Administration Security
window and clicking the Remove button (the red “minus” icon). Users will be asked if they are
sure they would like to remove the selected security level; click OK to proceed or Cancel to
abort the removal. Users will not be able to remove any of the Controller’s default starting secu-
rity levels.

Edit—This button (located on the lower-left corner of the Administration preference window)
opens the Edit Security Level window; this window is documented on page 27. 
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Creating A New Security Level
This window, which allows users to create their own custom security levels, can be accessed by clicking on
the Add button (the red “plus” icon located on the lower-left corner of the Administration preference
window’s Security tab).

If you would like to create a new security level based on an existing security level and its list of enabled and
disabled security options, select (highlight) the security level that you would like to have duplicated from
the Based On field, enter a new Security Level Name, and click the OK button. 

You may also choose to create a new security level that isn’t based on any that currently exist in your
system. In this instance, you would want to choose All Permissions On or All Permissions Off from the
Based On field; some users will find it easier to have all of their security options enabled or disabled when
creating a new security level from scratch.

After you have successfully created/duplicated a new security level using the Create New Security Level
window, it will appear in the Security Levels field of the Administration preference window’s Security
tab. 

From this point on, you may treat the newly created/duplicated security level as you would any existing
security level; it may be edited, it’s name changed, or it may be completely removed from the system.
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Editing A New Security Level
This window, which allows users to edit an existing (custom or default) security level, can be accessed by
selecting (highlighting) one of the Security Levels on the Security tab of the Administration preference
window and then by clicking on the Edit button (located in the lower-left corner).

You may toggle1 between any of the Controller’s existing security levels using the drop-down menu located
at the top-left corner of the Edit Security Level window. You can use this drop-down menu as a quick
reference to see how other security levels operate or to quickly change a specific permission on several
different security levels.

You may edit the name of the current security level by clicking on the Edit Name button (the blue “a”
icon). Doing so will open the Query window (shown below). Input the new security level name and click
OK when you are satisfied with your changes. Users will be unable to change the names of the Controller’s
default starting security levels and each security level name must be unique.

You may add a new security level from the Edit Security Level window by clicking on the Add button
(the red “plus” icon). This button opens the Create New Security Level window; this window is
documented on page 26. 

1.In technical terms, toggle means “to alternate between two or more electronic, mechanical, or computer-related options, usually by
the operation of a single switch, drop-down menu, or keystroke (e.g. toggled back and forth between two windows on the screen).”
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NOTE:
If you would like more 

information on a specific 
security permission, you 
can examine their Tools 

Tips by holding down the 
<ctrl> (Windows) or 
<option> (Macintosh) 
key and moving over the 

permission names.
You may remove the current security level by clicking on the Remove button (the red “minus” icon).
Users will be asked if they are sure they would like to remove the selected security level; click OK to
proceed or Cancel to abort the removal. Users will not be able to remove any of the Controller’s default
starting security levels. Once a security level has been deleted, it can not be restored.

The blue Enable All icon located in the upper-right corner of the window will activate (enable) all of the
permissions for the current security level. The red Disable All icon located next to it will disable all of the
permissions for the current security level.

Alexandria Controller security permissions are categorized and compartmentalized into groups of similar
permissions. You may toggle1 between these categories of permissions using the Categories drop-down
menus and tabs provided in the Edit Security Level window.

By clicking on the checkboxes contained within the tabs and menus of the Edit Security Level window,
you can enable or disable specific security permissions for the existing security level. 

When you have finished editing all of your security permissions, click Save to keep your changes or
Revert to discard them. You will be required to Save or Revert before toggling between any other
security levels or closing the Edit Security Level window.

1.In technical terms, toggle means “to alternate between two or more electronic, mechanical, or computer-related options, usually by
the operation of a single switch, drop-down menu, or keystroke (e.g. toggled back and forth between two windows on the screen).”
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Updates Tab
The Alexandria Controller can be updated automatically over the World Wide Web.

Automatically Check for Program Updates—If this box is checked, the Controller will automatically
check for product updates on start-up. If newer versions of the program are available, an entry will be
placed in the log. You can also download updates via the Check for Updates utility.

Automatically Download Missing Resources—If this box is checked, the Controller will automatically
verify on start-up that you have the latest versions of the client resources. Status entries will be placed in
the log, and if any resources are missing, they will be automatically downloaded.

Check for Program Updates Now—Clicking this button will immediately check for available
Alexandria Controller updates from the update server. If they are available, you can download them.

Check Resource Configuration Now—Clicking this button will immediately check your Alexandria
Controller installation for any missing resources. If you are missing resources, you can download them.

Status—This will display a status report of update and resource information. It will not download any
resources or updates, or modify your configuration in any way.

Update Server Address—This is the IP address of the COMPanion Update Server (usually
updateserver.companioncorp.com:80). Normally, this will only be changed if you are behind a
firewall. The Reset button will revert to the default update server address. Changes will not take effect
until the next time that the Controller is restarted. 

Maximum Simultaneous Client Updates—This allows you to limit the number of connected clients
that may download updates. The remaining clients will be placed in a queue while other clients finish
updating.
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NOTE:
Make sure to read the 

Read-Me file thoroughly
for important information 

regarding the update.
Performing Software Updates
There are two ways you can perform software updates from within the Alexandria Controller. If you have
an internet connection, you can check for Alexandria Controller updates using COMPanion’s Update
Server. If you select File, Utilities, Check For Updates, and an update is available, a description of the
update is shown under the Get Read-Me selection. From there, you can choose to update the Alexandria
Controller or wait for a future date. If you are sure you want to update to the newest version of the
Controller, an easier method is to use the Updates tab in the Administration preference window under
Edit, Preferences.

You can also download the newest COMPanion and Alexandria Controller software updates from the
official website (www.companioncorp.com). Just follow the Products and Software Updates
hyperlinks. You must enter your Alexandria Controller registration name, email address, school/company
and serial code in order to proceed with the download; these can be found on the registration letter you
received when you purchased the Controller or when you renewed your support contract. 

If you have accidentally misplaced your registration letter, COMPanion’s 24 hour Technical Support team
will be able to assist you.

If you don’t have a reliable internet connection (or are unable to download the newest updates), you can
contact COMPanion (via email or Tech Support at 800-347-4942) and request that an Alexandria
Controller Update CD-ROM be sent to your location.
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Library Information Preferences
Use these preferences to configure technical district email information.

Library Information Tab

Email notifications are sent to all District Administrators who have supplied email addresses. If, for some
reason, a Data Station unexpectedly stops running, the Alexandria Controller will send an email notice to
all of the District Administrators.

SMTP Server—This is the TCP/IP or DNS address of your library’s mail server. Typically, this
will be “mail.” followed by your domain name. You must enter a valid SMTP Server address to
use email services. Default is blank.

Test Server—This button tests the SMTP mail server by sending a test email.

Log In—Enter the log in or user identification for the email sever.

Password—Enter the password for the email server.

Use SSL—Short for Secure Sockets Layer; check this box if you would like to apply another pro-
tocol for transmitting data securely over the World Wide Web. While SSL provides for higher
security email transfers, it is not compatible with all email servers.

Use the COMPanion mail server to send support email—Check this box to use the COM-
Panion mail server when sending emails to (for example) Technical Support.
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Scheduled Events Preferences

Archive Tab
The Archive window allows you to schedule automatic backups of all your valuable Alexandria Data
Station information. This preference keeps three backups inside the Archive folder, which is located in
your Alexandria Controller Support system folder. Clicking on the Open Archive Folder button will
open the application support directory where all your archived data is stored.

When it’s time for an archive, all information in your Data Station’s Data folder is copied to a
subdirectory in the Archive folder. All services on the Data Station being archived are disabled.1

Although you can disable the automatic archiving function, this is not recommended. Your most recent
archives (combined with your off-site backup) are invaluable in securing the safety of your library data. 

1.This feature will archive all of your managed and active Data Stations.

- N O T E -

The Data Station must be Running when you have the archive scheduled to take
place. Thus, if the administrator doesn’t want to leave their computers running
overnight, they should change the default time(s) that the program is set to archive.
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NOTE:
rchives are not a backup! 
eeping an offsite backup 

is highly recommended.

Archives come in handy 
when trying to fix a bad 
import, but are entirely 
useless in the event of a 

system crash. 
How Archiving Works
If the Archives To Keep drop-down menu is set to anything below four (including zero), the Archive
Now button will keep five manual archives (as though the Archive To Keep preference was set to 5) and
when a sixth manual archive is requested, the Controller will first create a new data archive before
removing the oldest archive in the Alexandria Controller Support > Archive folder. 

In other words, every time you click the Archive Now button, the Controller will perform a manual
archive (even if your Archives To Keep is set to zero). However, if your Archives To Keep preference is
set higher than 5, then the Archive Now selection will no longer ignore the Archives To Keep
preference; in other words, manual archives will now be restricted to the specified Archives To Keep
value.

The Alexandria Controller will perform an automatic archive based on the value specified in the Archives
To Keep drop-down menu. Therefore, if your Alexandria Controller Support > Archive folder
contains more archives than the Archives To Keep preference states, the Controller will remove all of the
surplus archives (oldest archives first) after it creates a new automatic archive.

For example, if you have the Archives to Keep preference set to 2 and the Controller has already created
two automatic archives in the Alexandria Controller Support > Archive folder, you will be able to add
three additional manual archives to the folder, equalling five total archives. 

If the Archives to Keep preference is set to 10 and the Controller has already created four automatic
archives in the Alexandria Controller Support > Archive folder, you will be able to add six additional
manual archives to the folder.

During an automatic archive, if the Archives to Keep preference is set to 2 but you have manually created
three additional archives, the Controller will create a new automatic archive before deleting the three
oldest archives in the Alexandria Controller Support > Archive folder. This way, the number of
remaining archives will match the value specified in the Archives to Keep preference (in this instance,
two). 

Use the Refresh button to update the dates and times for the Next Scheduled Archive, and Last
Archive.

A
K
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Rebuild Tab
The Rebuild tab allows you to schedule automatic rebuilds for all of your managed Data Stations. The
Rebuild tab will show the date of your next scheduled rebuild and also display the date of your last
automatic or manual rebuild.

Use the Refresh button to update the dates and times for the Next Scheduled Rebuild, and Last
Rebuild.
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Archiving and Rebuilding with Alexandria Controller
Using the Alexandria Controller, you can schedule archives and rebuilds for all your managed Data
Stations. The actual rebuilds and archives, however, are performed individually by each Data Station.

While an archive or rebuild is taking place on a controlled Data Station, it’s progress is shown on the
Controller’s interface window.

When your Data Station is managed by the Alexandria Controller, client workstations will no longer have
the ability to directly edit their Data Station’s Archive location. Instead, this location is Set for all your
managed Data Stations in the Archive preferences of the Controller itself.

Furthermore, when an Alexandria Controlled Data Station is forced to rebuild on startup, it’s Data folder
is also archived to the location Set in the Controller's Archive preferences.

If the Archive folder is removed, the Controller will recreate the folder. If it can’t recreate the folder, it will
revert back to the standard, default location. This way, your Data Station will always have its archives saved
in the correct location.
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Alexandria Controller Utilities
The Controller’s Check for Updates utility downloads important updates to your software.

Check for Updates

Check for Updates
This utility will check for any available Alexandria Controller or Data Station updates. If there
are any available, they will be presented and you will have the option of choosing which you
would like installed. You should Archive your Data Stations before performing an update; we
recommend that you read the release notes thoroughly beforehand to ensure that your hardware
meets the minimum system requirements and so that you are aware of any major software
changes that were made.

Get Resources
This utility will verify that you have the latest versions of the client resources. If any resources are
missing or there are new resources available, they will be downloaded.
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What Happens When the Alexandria Controller Timeouts?
The Alexandria Controller contains advanced Multi-Data Station technologies. Although it’s not necessary
to understand how the Controller does what it does, this section is for the technical person who wants to
know a little more about what happens when the Alexandria Controller quits or times out.

• Quitting the Alexandria Controller causes all of the Data Stations to quit. Non-responsive Data
Stations are forcibly terminated after five seconds with an additional five seconds for each active
Data Station.

• When the Alexandria Controller is shutdown, Remote Control procedures on the client
workstation are ignored and anyone working on that workstation will be instantly disconnected.

• Before the Alexandria Controller quits after downloading an update, it will forcibly terminate
all of the active Data Stations first. 

• When the Alexandria Controller needs to quit, it will time-out after eight seconds with an
additional two seconds per active Data Station.

• Remote Control is ignored when the Alexandria Controller performs an update, checks for
updates, or performs an archive.

¡ W A R N I N G !

COMPanion recommends that all maintenance to your Alexandria Controller or
managed Data Stations be done after business hours as the Alexandria Controller
ignores Remote Control procedures for some actions
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